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Введение 
Не смотря на техническую оснащенность и автоматизацию процесса, современному 
астрофотографу приходится не легко. Почти все объекты, доступные любителям уже 
сняты. А в фокусах в районе 500мм совсем тяжело. Однако, в не зависимости от 
оборудования, нам хочется сделать особенный снимок. Один из способов достижения 
цели вытянуть в изображении скрытые цвета, получить красочный снимок подчеркнуть 
интересные детали. В данной статье я постарался объединить максимальное количество 
приемов постобработки на примере одного изображения в виде пошаговой инструкции 
Для своего повествования я выбрал хорошо известную галактику Андромеды М31. Это 
объект найдется в архиве каждого астрофотографа. 
М31 богатый цветами объект. В центре преобладают теплые оттенки с коричневыми 
прожилками темных туманностей. На периферии присутствуют синие области 
звездообразования и звездные скопления. Саму галактику окружает голубое гало. Кроме 
того, в галактике присутствуют водородные туманности. 
Все эти цвета на исходных фотографиях весьма блеклые и ставят перед нами не простую 
задачу по их вытягиванию. Я постараюсь в данной статье описать основные методы  
цветокоррекции, которые Вы можете применить к любому астрономическому 
изображению. Кроме цветокоррекции будут затронуты методы удаления градиента, 
повышения контраста и коррекции звезд 
Итак, поехали! 

Часть 1. IRIS. 
М31 Гора Майданак, Узбекистан, aвгуст 2007г Canon 20d (Родной ИК фильтр) SW80ED с 
редуктором WO 30 кадров по 8мин ISO800. 
На  рис.1 представлен снимок сразу после сложения и кадрирования в IRIS. 

 
Рис 1. 
 
Выравниваем фон. Для выравнивания фона мы будем использовать стандартную функцию 
IRIS   Processing > Remove gradient (Polynomial fit ). Для успешного выравнивания нам 



нужно создать маску и сообщить с ее помощью IRISу где у нас на изображении фон, а где 
объект. Маска создается при помощи команды bin_down [X], где Х пороговое значения 
яркости. Все что меньше этого значения станет белым, все что больше – черным. 
Поскольку мы будем вытягивать гало галактики, я постарался подобрать такое значение 
Х, при котором вся галактика вместе с гало оказывается в «черной зоне». 
На рис. 2 представлен скрин после применения команды  bin_down 180. 

 
Рис.2 
 
Исполнение команда save [mask] приводит к сохранению маски в виде изображения с 
именем mask. Открываем изображение галактики, заходим в меню  Processing > Remove 
gradient (Polynomial fit ). Заполняем поля, как на рис.2 В поле mask указываем имя нашей 
маски. 
Теперь пришло время баланса белого. Чтобы баланс был правильным надо удалить фон. 
Фон на изображении не обязательно серый. Скорее всего он ближе к цвету естественно 
засветки неба. Для удаления фона найдите в отдалении от галактики свободное от звезд 
место. Выделите его, и примените команду black. Данная команды приводит к вычитанию 
фона таким образом, чтобы среднее значение внутри квадрата было равно нулю. Обратите 
внимание, что некоторые пиксели после применения этой команды могут принимать 
отрицательные значения. Это нормальная ситуация для IRIS. 
На рис. 4 показано применение данной команды. 
Теперь мы подошли вплотную к самому балансу белого. От успеха следующего шага 
будит завесить очень многое. Существует много способов установки баланса. Баланс по 
звезде, баланс по группе звезд, баланс по предварительной калибровке камеры и баланс по 
объекту. Я обращусь к последнему способу. Всем известно что на периферии Андромеды 
существуют синеватые зоны звездообразования и скопления звезд. Ближе к центру 
галактики преобладают теплые тона. Чтобы проявить цветовое многообразие галактики и 
подчеркнуть переходы между этими зонами мы должны вбить между ними «серый клин». 
Т.е. серая точка должна находиться между этими оттенками, тогда зоны 
звездообразования уйдут в зону холодных оттенков, а внутренние области галактики в 
зону теплых оттенков. Далее усиливая цвета мы разведем друг от друга теплые и 



холодные оттенки. Вбивается «серый клин» очень просто. Выделим на изображении 
область в которой по нашему мнению есть  и то и другое и применим команду white. 
Рис.5. 

 
Рис. 3 
 

 
Рис.4             



 
Рис. 5 
На рис. 6 представлен результат выполнения команды white 

Рис.6 



Команда white умножает RGB каналы на коэффициенты таким образом, чтобы среднее 
значение всех пикселей внутри выделенной области во всех каналах было равно. Иными 
словами изображение внутри серой области становится в среднем идеально серым. 
Если Вам не понравился результат просто выберете другую область и повторите команду. 
На рис. 6 хорошо видно разделение между цветами зон звездообразования и средней 
частью галактики. Успешный баланс белого – залог успеха! Можно идти дальше. 
Вспоминаем про фон. Он у нас не реально черный. Добавляем к изображению небольшую 
константу при помощи команды offset. Я использовал значение 50. Оно позволяет 
уверенно вывести фон из отрицательных изображений. Рис. 7 иллюстрирует применение 
команды offset. 

 
Рис.7 
 
Отвлечемся не надолго от нашей Андромеды. Я хочу обратить Ваше внимание на одну 
проблему, про которую часто забывают. Скрытую угрозу представляют объекты, по 
большей части звезды, ушедшие в ограничение приемника. Яркая звезда в не зависимости 
от ее цвета и от баланса белого камеры всегда будет иметь значение в  RGB каналах, 
равное максимальному возможному значению аналого-цифрового преобразователя 
камеры. Для Canon 20D это 4095(R) 4095(G) 4095(B). Очевидно, что такой объект после 
баланса белого прямит иное не «белое» значение. На рис. 8 схематично показаны 
значения яркости в каналах RGB для звезды ушедшей в ограничение и для объекта, по 
которому мы выполняем баланс.  До баланса белого значения RGB были равны между 
собой. После баланса значения перестали быть равными и приобрели цветовой оттенок. 
Этот цветовой оттенок ни имеет ничего общего с цветом звезды. Если Вы прибегните в 
последствии к усилению цветов, то этот посторонний оттенок многократно усилится и 
испортит изображение. Для борьбы с этим я предлагаю обрезать изображение по уровню, 
равному значению минимального канала RGB после баланса белого. В примере на рис. 8 
это уровень красного канала. Уровень обозначен пунктирной линией «отсечка». 
 
 



 
Рис.8 
 
Стоит отметить, что этот метод несколько грубоват. Применительно к примеру на 
рис 8,  можно предположить существование объекта значение которого в R канале 
будет чуть ниже уровня отсечки, а в G и B каналах чуть больше. Предложенный мой 
метод, приведет к безвозвратной потери цвета такого объекта. Однако, не велика 
потеря. Речь идет о очень ярких объектах, звездах и верхушек туманностей. Если стоит 
цель сохранить цвет для них, то необходимо применять полноценный HDR. Аккуратный 
метод отсечки погоды не сделает. 
 
Вернемся к Андромеде и применим на практике отсечку. Для наглядности установим 
верхний ползунок регулятора Threshold в максимальное правое положение. На 
изображении останутся только самые яркие объекты. Наводя на них курсор мыши можно 
легко получить значения RGB в областях, которые ушли в ограничение при съемке 
Андромеды. Значения пикселя, на который указывает мышь приводятся в правом нижнем 
углу окна IRIS. Рис. 9.  Измерения показывают 17746(R)  11388(G)  20716(B) Минимальное 
значение у зеленого канала 11388. Обрезать по нему не составляет труда. Для этого нужно 
загнать этот уровень в максимально возможное значение 32767.  Все остальные каналы 
после умножения дадут величины превышающие 32767 и обрежутся автоматически. 
Заходим в меню Processing>Multiply. И умножаем все изображение на результат деления  
32767/11388. Отсечка выполнена. Все «сгоревшие» звезды и центр М31 стали нейтрально 
белыми. 
  
 



 
Рис.9 
Полученное изображение нуждается с сжатии динамического диапазона. Яркость 
периферии и близких к центру частей отличается примерно в 30 раз. И это даже без учета 
самого центра, который у меня сгорел на фотографии. Для его вытягивания потребуется 
полноценный HDR. А это уже тема отдельной статьи. 
Так или иначе, попрощаемся с самым центром галактики и попытаемся не потерять всего 
остального. И периферия и центральные части одинаково важны. Нам понадобиться 
функция ASINH в IRIS. View>Color stretching   Это функция производит нелинейное 
преобразования яркости изображения и цветовой насыщенности. Проявляя слабые 
объекты и предотвращает потерю структуры в ярких. Одновременно происходит усиление 
цветовой насыщенности. Параметр Stretch определяет степень нелинейности.  
Intensity определяет просто уровень после выполнения операции.   
Функция может быть вызвана и из командной строки ASINH [ALPHA] [INTENSITY]. При 
этом, диапазон возможных параметров шире, чем при вызове функции из меню. Однако 
теряется возможность предварительного просмотра результата. 
Выбор параметра Stretch (ALPHA) – чистое шаманство. Хотя и можно сформулировать 
основные принципы 

 Чем шире динамический диапазон изображения, тем  Stretch должен быть больше. 
 Чем ярче цвета в исходном изображении, тем Stretch должен быть меньше 

Поэкспериментируйте с параметрами для достижения оптимального на Ваш взгляд 
результата 
На рис. 10 Вы можете увидеть параметры, которые выбрал я и результат их применения. 
После применения ASINH, максимальный уровень яркости на изображении стал 
составлять 2296. Я умножил изображение попиксельно на 10. Теперь оно хорошо 
укладывается в динамический диапазон. Пришло время сохранить изображение для 
последующей обработке в Photoshop. В IRIS для этого припасены команды savepsd и 
savepsd2. Команда savepsd2  транслирует изображение  диапазоном -32768..32767 в 
0..65535 и является более универсальной в отличии от savepsd, которая не воспринимает 
отрицательных значений. Поскольку в нашем файле отрицательных значений яркости нет, 
я применю команду savepsd. 



 
На этом попрощаемся с IRIS. Все самое интересное впереди. В Photoshop! 
 

 
Рис.10 

Часть 2. Photoshop: обработка в RGB 
 
Открыв в Photoshop сохраненный в IRIS файл, в первую очередь применяем уровни. 
Я установил ползунки как на рис 11. Белый ползунок я установил на край гистограммы. 
Субъективно хочется сдвинуть его влево, это приводит к осветлению изображения. Не в 
коем случае его нельзя двигать левее. Это приведет к «сгоранию» ярких звезд и центра 
галактики 

Рис.11 



 
Далее переходим к корректировки при помощи кривых. 
Глядя на изображение мы видим, что фон слишком яркий, не хватает контраста на 
галактике, сгоревший центр галактики слишком бросается в глаза. 
Стандартная ситуация для применения S-образной кривой. рис.12. Остановлюсь 
подробнее на стирании границы сгоревшего центра. Плавный переход от сгоревших 
областей к тем что не вышли за пределы динамического диапазона матрицы достигается 
нахождением их на очень пологом участке кривой. Я навожу мышь на сгоревший центр и 
кликую при нажатой кнопке Ctrl. Это приводит к появлению на кривой точки, которая 
соответствует точке на изображении, указанной мышью. Далее я отвожу мышь на 5-10 
пикселей в сторону и повторяю операцию. В результате мы имеем 2 близкие точки на 
кривой в ее правой части. Рис.12. теперь при помощи стрелок вверх и вниз на клавиатуре 
я осуществляю точную корректировку положения точек по вертикали. Я стараюсь 
подогнать яркость области, окружающий центр галактики к яркости самого центра. Это 
стирает грань между ними. Ctrl+Tab позволяет переключаться между точками. Этот прием 
предоставляет возможность исключительно точной корректировки кривых.  Меня вполне 
устроил результат на рис. 13. Центр не бросается в глаза, фон не такой яркий как раньше, 
но гало отчетливо видно 
 

 
Рис.12 
 
 
На этом мы закончим предварительные регулировки и проанализируем изображение по-
канально. RGB каналы представлены на рис. 14. Анализ каналов показывает, что 
наивысший контраст присутствует в синем канале. Можно было просто взять его в 
качестве яркостного канала, но уж больно он шумный. При детальном изучении синего 
канала становится ясно, что видимая контрастность в первую очередь достигается за счет 
более хорошей проработке темных туманностей. Это и понятно. Синяя часть спектра 
наиболее сильно давится при прохождении света через темные туманности. 



Напрашивается идея взять из синего канала только темные туманности и наложить на 
яростный канал RGB композита. 

 
Рис.13 
 

 
Рис14.А    Красный канал 
 



 
Рис14.B    Зеленый канал 

 
Рис14.С    Синий канал 
 
Нет ничего проще сделать это в Photoshop! Темные туманности в синем канале темнее, 
чем в  яркостном канала RGB композита. 
Дублируем нижний слой Backgraund . Делаем полученный слой Backgraund copy 
активным и применяем команду Image>Apply Image 
Параметры Apply Image приведены на рис. 15 
 



 
Рис. 15. 
 
Команда «Apply Image» воздействует на активный слой (terget) любым каналом в любом 
слое любого открытого файла (Source) используя один из режимов смешения слоев 
(Blending). Я выбрал режим Darken. После применения команды на слое Backgraund copy  
все участки изображения более яркие, чем аналогичные участки в синем канале будут 
заменены на содержимое синего канала. 
Изображение галактики на слое Backgraund copy  после применения команды «Apply 
Image» стало более рельефным. Темные туманности как будто пропечатались на фоне 
галактики. При этом темные туманности неизбежно  обесцветились. Это не проблема. 
Меняем blending mode для слоя Backgraund copy  на Luminosity, как это показано на 
рис.16А. Теперь слой  Background copy   превратился в яркостный канал, а цвет берется со 
слоя Backgraund. Результат данного алгоритма повышения контраста приведен на рис 16. 
Слева до, справа после. Подчеркну, что усиление контраста было достигнуто без  
применения нерезкой мазки, деконволюции и прочих шарпов. Следовательно, мы не 
наблюдаем артефактов указанных методов в виде окантовок вокруг звезд и контрастных 
частях туманностей. Информация для усиления контраста находилась в самом исходнике! 
Она заключалась в различии поглощения темными туманностями в зависимости от 
спектра излучения. Если бы мы просто доверили создание яркостного канала Фотошопу, 
то он бы просто сложил R G и B компоненты с некоторыми весами никак не учитывая 
отличия каналов в каналах. Информация была бы потеряна. 
 
 

 
Рис. 16 
 
 



  
Рис.16А 
 
Однако недостатки у метода все же есть. На периферии галактики появился шум, 
представленный разбросанными по изображению черными точками. Пострадали и яркие 
желтые звезды. В синем канале они слабее. В результате эти звезды стали мельче. Но цвет 
у нас берется со слоя с нетронутыми желтыми звездами. Это приводит к тому, что вокруг 
звезд образовались бублики фона, покрашенного в желтый цвет. Выглядит, мягко говоря, 
не очень. Пробежавшись по изображению, можно увидеть, что на фоне галактики нет 
ярких желтых звезд. Применив к слою Background copy   маску галактики, можно 
победить сразу оба недостатка этого метода. Но это, чуть позже. Сейчас сделаем из 
изображения маску звезд. 
Копируем еще раз слой Background и размещаем его поверх всех слоев. Слою 
автоматически присвоится имя Background copy 2. 
Сейчас стек слоев выглядит как на рис. 17. 



 
Рис. 17. 
 
Обесцвечиваем слой Background copy 2 при помощи команды 
Image>Adjustments>Desaturate. Делее применяем к результату фильтр Filter>Other>High 
Pass с радиусом 6 пикселей. После High Pass я применил к слою жесткие уровни, как на 
рис. 18. 
 

 
Рис. 18 
В завершении немного сгладил изображения применив размазывание гаусианой с 
радиусом 0.4 пикселя (Filter>Blur>Gaussian Blur). 
Далее я применяю к слою нерезкую маску (Unsharp mask) с параметрами Amount=200% 
radius=2Px, Threshold=0. Нерезкую мазку я применяю именно после уровней. Поскольку 
уровни отрезали шум, который неизбежно бы усилился нерезкой маской. Далее я сново 
сглаживаю маску легкой гаусианой с радиусом 0.4 пикселя . 
Кроп получившийся маски в масштабе 100% представлен на рис. 18А.  
На маске проявились практически все звезды но и резкие переходы на туманностях тоже 
просочились. Их я убираю черной кисточкой малого радиуса. При использовании кисти я 
периодически делаю слой маски не видимым, чтобы быть уверенным, что удаляю то, что 
надо. После всех операций я меняю название слоя на Star Mask 
 



 
Рис.18А. 
 
Вернемся к удалению артефактов, возникших после замещения яркостного канала 
красным с использование режима смешения Darken. У нас остался слой Background copy. 
Для решения проблемы необходимо применить к слою маску галактики. Т.е. маску на 
которой галактика будет белой, а окружающий фон черным. При этом, как отмечалось 
выше, на фоне галактики нет ярких желтых звезд, которые оказались испорченными. Т.е 
мы можем не исключать из маски галактики звезды. Это облегчает задачу построения 
такой маски. 
Скопируем слой  Background и назовем его Galaxy Mask. 
Сделаем активным и видимым слой Star Mask. Заходим в меню Select>Color Rang.  
Кликаем мышкой на темном участке снимка и устанавливаем ползунок Fuziness в 
положение 40 как показано на рис 19. 

Рис.19 



Жмем «ОК». Фотошоп выделил все кроме звезд. Делаем инверсию выделения 
Select>Inverse. Можно было кликнуть и на звезде и обойтись без инверсии, но кликать в 
темную область просто легче. Да и отделить звезды после этого на маске проще. 
Далее я расширяю маску при помощи команды Select>Modify>Expand с параметром 1 
пиксель. Чтобы проверить корректность выделения, я делаю все слои кроме  Background 
не видимыми. 
Результат представлен на рис 20 
 

 
Рис.20 
 
Делаем активным и видимым слой Galaxy Mask. Остальные отключаем. Нажимаем 
клавишу «Delete». Далее отключаем выделение комбинацией клавиш «Ctrl+D». На местах 
звезд получилась дырки. См. рис. 21. 

 
Рис. 21. 



Заполняем «дырки» окружающим их фоном. Для этого хорошо подходит фильтр 
Minimum. Фильтр вызывается из меню Filter>Other>Minimum. Я выбрал в качестве 
параметра значение 8 пикселей. Результат применения фильтра показан на рис.22. 
 

 
Рис.22. 
 
Теперь, когда явных «дырок» в изображении нет, его можно размазать фильтром Gaussian 
Blur c Радиусом 20-50 пикселей. Я использовал радиус в 30 пикселей. Далее я 
обесцвечиваю изображение командой Image>Adjustments>Desaturate и открываю окно 
редактирования уровней для данного слоя. Используя «белую» и «черную» пипетки я 
корректирую уровни. Пипетками я кликаю на галактику (верхний крестик) и на темный 
участок изображения (нижний крестик). Жму «ОК»  Рис. 22А. 

 
Рис. 22А. 



 
Маска галактики готова. Осталось ее применить к слою Background copy. 
Клавишами «Ctrl+A» и «Ctrl+C» я копирую маску в буфер обмена. Пиктограммой 
«кружочек в прямоугольнике» на палитре слоев я создаю маску к слою Background copy. 
Захожу в палитру каналов, делаю свежую маску активной и помещаю на нее содержимое 
буфера обмена. Все готово! Наш стек слоев теперь выглядит как на рис. 23. Все артефакты 
смешения синего слоя с яркостным нейтрализованы. Мы взяли все из исходников и 
ничему при этом не навредили. 
 

 
Рис. 23. 
Более слои Background и Background copy по отдельности нам не нужны. Комбинация 
клавиш «Ctrl+Alt+Shift+N+E» приводит к созданию нового слоя, на который собрано 
композитное изображение всех видимых на момент применения команды слоев. Я его 
переименовал в «M31-base». 
Дальнейшая обработка потребует раздельного подхода к звездам и к галактике. Типичный 
подход к разделению звезд и объекта, использование преобразований по маске звезд (или 
инверсной маски звезд если речь идет об обработке туманности). Однако этот метод имеет 
существенные недостатки. Граница раздела звезда/туманность становится заметна после 
обработки. Наиболее характерно появление темных бубликов вокруг звезд или бубликов 
отличного от остальной туманности цвета. Причина этого эффекта становится понятна, 
если обратится к иллюстрации на рис. 24. На рис. 24 а) изображен разрез изображения с 
туманностью и звездой. По оси абсцисс отложен ряд пикселей, а по ординатам – яркость. 
Красным изображена туманность, а синем звезда. Вертикальные пунктирные линии 
обозначают границу маски звезд. На рис. 24 б) мы подвергли туманность «вытягиванию» 
по инверсной маске звезд. Т.е. вытягивали только туманность не трогая звезды. Хорошо 
видно, что вокруг звезды образовались провалы в яркости, которые видны на 
изображении в виде темных бубликов. На рис. 24 б) представлен результат коррекции 
цвета туманности по инверсной маске звезд. Вокруг звезды остается часть туманности, 
которой не коснулась коррекция. На границе маски виден резкий цветовой переход. 
В целом, можно сказать, что чем агрессивнее делается обработка туманности по 
инверсной маске звезд, тем труднее скрыть переходы от туманности к звездам после 
обработки. 
 



 
Рис. 24. 
 
Есть способ лишенный указанных недостатков. Суть метода в том, чтобы разделить 
изображение на два слоя. Первый состоит из звезд на абсолютно черном фоне (Рис. 25 b). 
Второй представляет из себя туманность и фон без звезд в котором «дырки» из под звезд 
заменены аппроксимацией туманности. Т.е. среднем значением пикселей, окружающим 
«дырку» из под звезд. (Рис. 25 с). Далее слой звезд и туманности обрабатываются по 
отдельности. К примеру, можно усилить туманность, как показано на рис. 25 d). После 
обработки слои складываются (Рис. 25 e). Подчеркиваю, именно арифметически 
складываются попиксельно, а не совмещаются по маске. 
 



 
Рис. 25 
 
Поскольку при совмещении звезд и туманности используется арифметическое сложение, а 
не совмещение по маске, проблем на границе звезд и туманности нет! Как таковых границ 
при совмещении просто нет. Однако, просто не будет. Залог успешности метода в 
качественном удалении звезд с изображения. Т.е. получения из изображения рис 25.а)  
изображения на рис. 25 с) 
Посмотрим, что  для этого есть в Фотошопе 
Дублируем слой «M31-base». Я его назвал Star Patch  
Используя слой StarMask создаем выделение для звезд при помощи Color Range. В этот 
раз я выбрал значение Fuzzines равное 5. Данный параметр защитит нас от плавных краев 
выделения. Далее я расширяю выделение при помощи команды Select>Modify>Expand 3 
пикселя. Удаляем звезды по маске. Не отключая выделение, я применяю к выделенной 
области фильтр Minimum с радиусом 1 пиксель. Далее я уменьшаю выделение при 
помощи команды Select>Modify>Contract 1 пиксель. После этого снова применяю фильтр 
Minimum с радиусом 1 пиксель и т.д. повторяю эти две операции пока дырки из под звезд 
не затянутся. Внимание! Выделение снимать нельзя. Оно должно оставаться и постепенно 
сужаться по мере затягивания дырок из под звезд. 
Зачем нужна такая сложная последовательность? Дело в том, что фильтр минимум 
приводит к заполнению вырезанного пространства значением минимального пикселя в 
заданном радиусе. Если применить фильтр один раз с большим радиусом, то цвет 
«заплатки» вместо звезды будет однотонным и соответствовать минимальному цвету 
окружающего пространства. Это не есть хорошо. Звезда может находиться на фоне резких 
цветовых переходов туманности, и заплатка минимальной яркости будет смотреться не 
естественно бросаться в глаза. Предложенный мной способ позволяет «затягивать» дырку 
из под звезды равномерно со всех сторон. При этом иногда даже сохраняется текстура 



окружающей туманности. Метод очень чувствителен к контурам выделения. Если они не 
резкие, то после выполнения описанной выше последовательности действий, на 
изображении будут оставаться множественные точки с частичной прозрачностью. 
Если вы столкнулись со сложностями, попытайтесь заменить команду Contract командой 
Color Range Для того, чтобы найти новые контуры незатянутой дырки каждый раз после 
применения фильтра Minimum. 
Как ни крути, на изображении все равно остаются незаполненные единичные пиксели. Но 
это не проблема. Я дублирую слой Star Patch. Применяем фильтр Minimum с радиусом 2 
пикселя ко всему изображению на нижнем из двух слоев Patch (ранее он применялся 
только к области выделения). Все, готово! Теперь через единичные прозрачные пиксели 
верхнего слоя Patch виден нижний слой, где эти пиксели заполнены адекватными 
значениями. Нижний слой Star Patch я переименовал в Star Patch Min 2px по 
наименованию фильтра, примененного к слою. На рис. 26 показан результат удаления 
звезд в 100% масштабе 
 

 
Рис. 26. 
 
Остались только светлые пятна на фоне крупных звезд. Причина их появления в том, что 
маска не захватила ореолы от звезд. И при затягивании дырок от звезд, был взят цвет 
ареола, а не окружающего фона. К счастью, на фоне галактики таких звезд мало, в 
основном они находятся за «пределами» границы галактики. Там не нужно особой 
аккуратности, чтобы их побороть. Для начала соберем слои Star Patch и Star Patch Min 2px 
при помощи комбинации клавиш «Ctrl+Alt+Shift+N+E» на новый слой. Назовем его Star 
Patch & Star Patch Min 2px. Далее копируем слой Star Mask и применяем к нему фильтр 
Gaussian Blur с радиусом 1.5px. Слою я присваиваю имя Star Mask GB1.5 px и делаю 
активным. Вызываю инструмент  Color Rang. Кликаю мышкой на центр яркой звезды. 
Параметр Fuzziness устанавливаю равным 1. Поскольку после  Gaussian Blur мелкие 
звезды слегка размазались, их верхушки просели в яркости. В результате выделение 
коснулось только крупных звезд! Увеличиваем зону выделения на 12 пикселей ( Expand 
12 пикселей). Теперь в выделение попали все крупные звезды. Делаем активным слой Star 
Patch & Star Patch Min 2px, выбираем инструмент Poligonal Lasso в режиме «исключения 
из выделения» и обводим галактику. Теперь в области выделения находятся крупные 



звезды за пределами контуров галактики (точнее не звезды а не совсем хорошие заплатки, 
которые необходимо причесать). Жмем кнопку «Delete». Заплатки вырезаются. 
Дублируем слой Patch & Star Patch Min 2px. Верхний слой автоматом получает название  
Star Patch & Star Patch Min 2px copy. На нижнем (Patch & Star Patch Min 2px) применяем 
фильтр Minimum с радиусом 12 пикселей (Как я уже говорил особую аккуратность тут 
применять нет необходимости в отличии от удаления мелких звезд на фоне галактики). 
 
Наш стек слоев теперь выглядит как на рис. 27. 
 

 
Рис.27 
 
А результат удаления крупных звезд представлен на рис. 28 
 



 
Рис. 28 
 
Согласитесь, не очень красиво.  Заплатки стали темнее фона. Это и очевидно. Фильтр 
Minimum выбрал для  заполнения значение минимального пикселя  в области, 
окружающей заплатку.  Понятно дело, что такой подход к удалению звезд в области 
галактики применять не желательно. 
В области же фона дело легко поправимо. Создадим между слоями «Star Patch & Star Patch 
Min 2px» и «Star Patch & Star Patch Min 2px copy» корректирующий слой кривых. Это 
можно сделать используя команду меню Layer>New Adjustment Layer>Curves. Новый слой 
автоматом получает название «Curves1». В Фотошопе корректирующий слой имеет 
действие на изображение созданное, всеми слоями расположенными ниже. Это можно 
поправить. Я размещаю курсор ровно между слоями «Star Patch & Star Patch Min 2px» и 
«Star Patch & Star Patch Min 2px copy», Нажимаю левую клавишу мыши при нажатой 
кнопке «Alt». Теперь слой «Curves1» привязан к слою «Star Patch & Star Patch Min 2px»и 
действует только на него. Стек слоев показан на рис. 29 



 
Рис. 29 
 
Кривые призваны поднять яркость заплаток и подогнать ее под яркость окружающего 
фона на верхнем слое. Сама кривая представлена на рис. 30, а результат ее применения на 
рис. 31. 

Рис. 30 



 
Рис.31 
 
Работа почти завершена. Остались только единичные звезды на краях галактики (Мы их 
специально удалили из выделения, чтобы не портить галактику грубым методом) и 
несколько самых ярких звезд в области фона. 
Собираем 3 верхних слоя в один новый при помощи комбинации клавиш 
«Ctrl+Alt+Shift+N+E» на новый слой. После долгих мучений я имею право назвать его 
«M31 Without Stars» 
Делаю вновь созданный слой видимым и активным и при помощи инструмента Healing 
Brush Tool (Расположен на 2 иконки выше хорошо знакомого Клон штампа в той же 
палитре) удаляю единичные звезды, устоявшие перед описанным методом удаления. Их 
совсем мало, и у меня уходит менее 10 мин. Все! Победа! Слой M31 Without Stars, 
действительно теперь представляет собой галактику, очищенную от звезд. 
Финальный результат удаления звезд представлен на рис. 32. Метод получился довольно 
громоздким. Однако при правильном исполнении он дает хороший результат по 
затягиванию «дырок» от звезд. Более простая реализация методики удаления звезд на 
основе фильтра Minimum представлена тут http://darkhorizons.emissionline.com/. 



 
Рис. 32 
 
Вычитанием из композитного слоя содержащего и звезды и галактику слоя только с 
галактикой легко получить слой звезд. Дублируем слой «M31-base». Фотошоп называет 
его «M31-base copy» и размещаем его поверх всех слоев. Делаем его активным и 
вызываем команду Image>Apply Image. Заполнив диалог команды как показано на рис.33. 
я нажимаю «Ок». Слой «M31-base copy» превращается в слой на котором представлены 
одни звезды на черном фоне. Я переименовал слой «M31-base copy» в «Stars». 
Изображение на слое представлено на рис. 34. Контуры галактики выдает лишь падение 
яркости звезд на ее фоне. В этом нет ошибки. В свое время еще в IRIS я выполнил 
нелинейное растяжение изображения. Галактика стала более яркой, а максимальная 
яркость пикселей как в районе галактики, так и в районе фона осталась одной и той же. 
Это означает что звезды на фоне галактике стали тусклее. Если бы я не делал нелинейного 
растяжения, яркость звезд на фоне галактики и за ее пределами была бы почти 
одинаковой. 
 

 
Рис. 33. 
 
 



 
Рис. 34. 
 
Чтобы наложить, а правильнее сказать сложить звезды с галактикой, необходимо 
изменить blending mode слоя «Stars» с Normal на Linear Dodge (Add). Теперь если оба слоя 
«Stars» и «M31 Without Stars» видимы, перед нами предстает галактика со звездами. 
Отключая и включая видимость слоя «Stars», можно наблюдать, как звезды появляются и 
исчезают с изображения. Теперь наш стек слоев выглядит как на рис. 35. 
Я сохраняю файл под названием «M31-RGB.psd». Работа с ним закончена. Его можно 
найти во вложении к статье. Подведем предварительные итоги нашей работы. 
В IRIS мы удалили градиент с изображения, скорректировали баланс белого и выполнили 
операцию нелинейного растяжения Color stretching. 
В Фотошоп мы смешали синий канал с яркостным с целью увеличения контраста темных 
туманностей, далее разделили изображение на два слоя. Один содержит галактику без 
звезд, другой только звезды на черном фоне. Вот собственно и все. Не так много, но 
теперь у нас есть надежный фундамент для дальнейшей обработки. 
 
 
 
 



 
Рис. 35. 
 

Часть 3. Photoshop: обработка в Lab 
 
Мы подошли к самому шаманскому этапу обработки - цветокоррекции галактики. 
Выбирая цветовое пространство для обработки, я остановился на LAB. Цветовое 
пространство LAB названо по 3-м его компонентам (L) (A) (B). L обозначает яркость или 
светлоту изображения (Luminosity), а A и B не означают ничего в отличие к примеру от 
RGB и CMYK. Каналы A и B отвечают за цветность изображения, при этом каналы А и В 
не связаны напрямую с каким либо цветом.  Канал А отвечает за баланс цветов между 
зеленым и пурпурным. А канал В отвечает за баланс цветов между голубым и желтым. 
Компоненты цветового пространства RGB напрямую связаны с цветами монитора. 
Цветовые каналы CMYK показывают сколько краски какого цвета использовать при 
выводе на печать. Компоненты цветового пространства LAB не связаны напрямую с 
устройством вывода изображения, но при этом это цветовое пространство имеет 
огромный потенциал для обработки изображения. Наиболее полное руководство по 
использованию цветового пространства LAB в Фотошоп представляет собой книга 
«Photohop LAB color Загадка каньона и другие приключения в самом мощном цветовом 



пространстве» Дэна Маргулиса. Книга не связана с астрофотографией, но все сказанное в 
ней можно без труда перенести в мир обработки астрофото. Кроме того, в интернете 
много статей по практическому применению данного цветового пространства при 
обработки фотографий. Применительно к астрофото цветовое пространство LAB 
позволяет лучше других вытягивать из изображения скрытые цвета не искажая при этом 
хорошо выраженные. Применение команды Hue/saturation в RGB не дает пользователю 
такого контроля над изображением, которое дает LAB. Еще одна особенность цветового 
пространства LAB в том, что обрабатывая в нем Вам легче добиться именно тех цветов, 
которые Вы хотите получить. Преимущество LAB заключается в том, что яркость или 
светлота изображения отделены от цвета. Цвета же представлены в виде двух 
монохромных каналов А и В, корректировать которые можно при помощи обыкновенных 
кривых (Curves). Я изложу основные принципы цветокоррекции в LAB и перейду 
непосредственно к обработке Андромеды. В Photoshop L канал представлен 
целочисленными значениями от 0 до 100. 0 соответствует абсолютно черному, а 100 
абсолютно белому. Каналы A и B изменяются в пределах от -128 до +127. нулевым 
значениям каналов А и Б соответствует нейтральный цвет (отсутствие цвета. Изображение 
идеально серое). Отрицательные значения в канале А свидетельствуют об зеленых  
оттенках изображения. Положительные – о пурпурных. Отрицательные значения в канале 
B отвечают голубым оттенкам, положительные – желтым. Чем дальше от нуля, тем 
насыщеннее оттенок (Рис. 39). Интересно, что в отличии от RGB или CMYK в LAB 
яркость и цвет абсолютно не связаны. Т.е. изображение может быть максимально ярким и 
при этом иметь цвет. В RGB токое невозможно. Максимальной яркий цвет это 255(R) 
255(G) 255(B) т.е. белый. Для любого изменения цвета необходимо уменьшить хоть одну 
из RGB компонентов. Но это приведет к неизбежному падению яркости. В LAB же вполне 
может существовать цвет 100(L) 0(L) 25(B). Т.е. одновременно максимально ярким и 
желтым. Пространство LAB заведомо шире RGB и CMYK. В LAB могут существовать 
цвета которые невозможно отобразить ни на одном типе носителей. В пространстве LAB 
цветовые каналы L, A и B можно независимо корректировать привычными средствами 
Photoshop. К ним можно применять фильтры, размазывать или повышать резкость. Основа 
же цветокоррекции в LAB заключается в применение к каналам L, A и B кривых (Curves). 
При этом каналы L, А и B редактируются как обыкновенные монохромные каналы.  
Коррекция светлоты  (Яркостного канала) при помощи кривых не нова. Это хорошо 
известный инструмент. А вот коррекция при помощи кривых каналов А и В нуждается в 
пояснении. Крутые кривые, показанные на рис. 36, примененные к каналам A и В 
приводят к увеличению контраста. Пологие (Рис. 37), наоборот, к снижению контраста. 
Сдвиг кривых в канале А в правую сторону (Рис. 38) приводит к смещению цветового 
баланса в зеленую область без изменения насыщенности. Противоположный сдвиг – в 
пурпурную. 
Сдвиг кривых в канале B в правую сторону приводит к смещению цветового баланса в 
голубую область без изменения насыщенности. Противоположный сдвиг – в желтую. 
Кривые, естественно, могут иметь отличную от прямых форму, по разному корректируя 
различные цвета. На первый взгляд, представление цветов в виде монохромных каналов, 
кажется не удобным. Однако, стоит только начать и уже очень быстро, понимаешь на 
сколько этот метод удобен. Я рекомендую для начала потренироваться на обыкновенных 
не астрономических фотографиях. Там первоначальный диапазон цветов шире и освоить 
пространство LAB легче.  
 
Для примера возьмем пейзаж, снятый в Ленинградской области (Рис. 40а.). Я испытал 
большую радость, когда после продолжительной непогоды, вдруг вышло солнце. Не 
удержался и сделал эту фотографию. Однако, в исходном варианте она не передает моих 
эмоций. 
Небо безжизненное. Радуга не выражена. Передний план сливается с задним. Лес на 
переднем и средних планах имеет желтоватый оттенок. Лес в долине из-за легкой дымки 



смотрится не очень. Постараемся это исправить одним корректирующим слоем кривых 
(Curves) в пространстве LAB. Корректирующей слой представлен на рис. 41. 
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Рис. 38 
 
 

 
 
Рис. 39 



 
Рис. 40а 

 
Рис. 40б 
 
 



 
Рис.41 
 
Для кривых в яркостном канале L я использовал S-образную кривую. Крутой участок 
кривой приходится на наиболее интересные участки изображений – лес и траву. Чем выше 
крутизна, тем выше контраст изображения. В результате дымка исчезает, лес приобретает 
выразительность.  
В канале A я ставлю задачу усилить переходы между зеленым и пурпурным. Для этого 
центральная часть кривой делается крутой. По краям кривая наоборот делается пологой. 
Это защищает от усиления уже достаточно яркие на исходном изображении цвета. 
К ним относятся листва на переднем плане, крыше домов, плоды на дереве на переднем 
плане. Кривая проходит левее центра графика (отмечен пересечением жирных черных 
линий). Это смещает общий цветовой баланс в сторону красных оттенков. 
В канале B аналогичная ситуация. Он отвечает за баланс между синим и желтым. 
Центральная часть кривой позволяет усилить цвет неба и сухой травы на переднем плане. 
Пологие участки защищают яркие цвета. Кривая проходит правее центра графика. Это 
сдвигает общий цветовой баланс в синюю сторону. Совместно со смещение цветового 
баланса в канала A, мы выправляем зеленовато-желтоватый оттенок фотографии. 
Результат коррекции представлен на рис. 40б. На все операции у меня ушло не более 2-х 
минут. В RGB у меня ушло бы гораздо больше времени. Данное изображение в формате 



Photoshop с корректирующим слоем находится в приложении к статье. Вы можете 
выполнить коррекцию на свой вкус! 
 

 
Рис.42а  
 
 

 
Рис.42б 
 

 
Рис. 43 канал L 



 
Рис. 44. Канал A 
 

 
Рис. 45. Канал B 
 
Вернемся к обработке Андромеды. Открываем файл «M31-RGB.psd» Удаляем все слои 
кроме «Stars» и «Galaxy Without Stars». Входим в меню преобразования профилей 
Edit>Convert to Profile. Заполняем диалог, как показано на рис. 42а и нажимаем «ОК». 
Фотошоп спрашивает нас, желаем ли мы объединить пред преобразованием все 
существующие слои в один. Этот вопрос связан с тем, что в RGB и LAB одни и те же 
операции наложения слоев могут приводить к разным результатам. У меня нет выбора, не 
для того я так долго отделял звезды от галактики. Я нажимаю кнопку «Don’t Merge» 
(Рис.42б). Отлично, теперь мы в LAB. Посмотрим, как выглядит наша галактика без звезд 
по-отдельности в каналах L, A и B. Канал L  (Рис.43) представляет собой яркостный 



канал. О нем можно сказать только то, что в LAB яркостный канал всегда светлее 
композита. 
 
Каналы А и В выглядят не привычно. Канал А отвечает за баланс цветов между зеленым и 
пурпурным. Как видно, изображение мало чем отличается от серого фона. Деталей почти 
нет. Это говорит о том, что переходов от зеленого к пурпурному в нашем изображении 
почти нет. От части это свойство объекта, от части дело в непеределанной цифрозеркалке. 
На снимке практически нет водорода. Интересный факт. Если просто заменить канал A 
серым фоном, разницы будет почти не заметно. Наше изображение мало чем отличается 
от биколора. (Я говорю только о галактике. Звезды получились более пестрые. Спасибо 
80ED. Каких только цветов там на звездах нет. С ними я буду бороться в самом конце 
статьи) 
Проанализируем канал A в числах. Активирую пипетку и устанавливаю усреднение 11x11 
пикселей. В районе центра галактики значение канала A колеблется около -2. Это говорит 
о присутствии зеленого оттенка. Он явно паразитный. В районе темных туманностей мы 
наблюдаем +3. В зоне водородных +6. Это не идет в разрез с природой. В этих областях 
сдвиг баланса в красную сторону логичен. За пределами галактики в области фона мы 
наблюдаем значения в районе +1 +2. Это говорит о легком дисбалансе белого  в области 
фона. 
Перейдем к каналу B. Мы наблюдаем более пеструю картинку, чем в канале А. Хорошо 
видны области звездообразования на периферии галактики. Они имеют синий оттенок. 
Синие тона в канале B представлены темными участками. Значение канала B доходит до  
-20. В местах темных туманностей мы наблюдаем значения +3 +4. Это и понятно, желтого 
там больше, чем синего. В центре галактики и в области фона мы наблюдаем колебания 
около 0. 
Я постараюсь усилить цвета в области зон звездообразования. Теплые тона в области 
желтых прожилок и темных туманностей я усилю в меньшей степени, они и так 
выразительны. Паразитный зеленый оттенок около центра галактики я смещу в область 
легких теплых тонов. В заключении, нейтрализую небольшой красный оттенок фона. 
Забегая вперед, отмечу, что исходной цветовой информации в канале A слишком мало для 
независимой коррекции этого канала. Для коррекции канал A я буду использовать наряду 
с самим каналом A и другие каналы. 
Начнем с коррекции яркостного канала L и канала B. В самом начале я применил к 
изображению предварительные кривые. Это позволило мне сделать изображении более 
контрастным. Но я оставил тогда фон значительно более ярким, чем хотелось. Сделал я 
это исключительно для того, чтобы при обработке четко видеть что происходит на 
периферии галактики где гало плавно переходит в фон. Теперь, на финальном этапе я 
могу затемнить фон. 
Я создаю над слоем «M31 Without Stars» корректирующий слой кривых (Curves) и 
называю его «Curves L&b» 
Этим слоем я проведу коррекцию яркостного канала L и канала B. На рис. 46 приведены 
кривые. В L канале я немного приглушил фон подняв крутизну, а следовательно, контраст 
в области перехода от фона к галактике. Канал A я пока не трогал.  Канал B отвечает за 
желто-голубую составляющую (Рис.39). Голубые оттенки на изображении присутствуют в 
области гало. Желтые - преимущественно, в области прожилок. Непосредственно под 
центром галактики присутствует довольно выраженная желтая область +13(b) (Рис.32). 
Мне необходимо построить такую кривую, которая усилит голубые оттенки гало, желтые 
оттенки прожилок и в меньшей степени коснется выраженной желтой области под 
центром галактики. Кривая для канала B представлена на рис. 46. Я повысил крутизну в 
центральной области. Это привело к усилению слабых желтых и голубых оттенков. 
Однако, в правой части (которая отвечает за желтые тона), крутизна меньше. Это 
защищает ярко вороженные желтые тона от чрезмерного усиления. 
На рис. 47 приведен результат применения подобных кривых (Для естественности далее я 
буду «включать» звезды на скриншотах). Изображение стало более контрастным. Голубые 



и желтые оттенки стали более яркими. «Кислотные» цвета не проявились. Стек слоев 
представлен на рис. 48. 

  
Рис.48. 
 
 

 
Рис. 46 
 



 
Рис.47 
Перейдем к коррекции канала A. Канал A отвечает за пурпуно-зеленую составляющую 
цвета (Рис.39). Как следует из рис. 44, канал A исключительно беден в плане вариаций 
яркости. Это означает, что на исходном изображении вариации между зеленым и 
пурпурном почти отсутствуют (я говорю исключительно о галактике, а не о звездах). 
Просто применить кривые к этому слою нельзя. Это приведет к чрезмерному усилению 
шумов в канале A. Я буду использовать для коррекции другие каналы. Исходное 
изображение (Рис. 32) выглядит зеленоватым в центре. Значения канала A лежат в области 
слабых отрицательных значений. Моя задача скорректировать этот цвет в центре 
галактики в сторону теплых оттенков и не затронуть периферию, которая на рис. 47 
выглядит уже не плохо. В противном случае, гало галактики сместится в область не 
естественных красных тонов. Я создаю новый корректирующий слой кривых. И называю 
его «Curves a» Кривые L и B я не буду трогать. Кривые для канала A представлены на рис. 
49. 
 

 
Рис.49. 



  
Я приподнял кривую вверх. Это привело к смещению изображения из зеленых тонов в 
пурпурные. К примеру, что точке «0» по оси абсцисс соответствует положительное 
значение +18. На кривой присутствует резкая ступенька. Ее задача предохранить 
прожилки темных туманностей от появления неестественного красного оттенка. 
Действует она очень просто. Темным прожилкам соответствуют значения в канале A +3 
+6. Этим значения находятся на дне ступеньки и они лежат близко к диагональной прямой 
y=x. Т.е. кривая ни как не влияет на эти точки. 
Сейчас данная кривая воздействует на все изображения. А я хотел ограничить ее действие 
только центральной частью галактики. Сразу напрашивается маска. Однако, Photoshop 
имеет в своем арсенале более простой и гибкий инструмент.  Я навожу курсор на слой 
кривых в стеке слоев, жму правую кнопку мыши и в всплывающем меню выбираю 
«Blending Options». Меню «Blending Options» представлено на рис. 50. В нижней части 
присутствует инструмент «Blend If:». 
Движки  Blend If позволяют исключать те или ли или иные части из рабочего слоя в 
зависимости от яркости того или иного канала. Операция схожа с использованием маски 
яркости. В конфигурации на рис. 50 движки отображают зависимость от яркостного 
канала L. Однако, регуляторы можно использовать и для каналов A или B. По умолчанию 
движки установлены в крайние положения, что заставляет Photoshop всегда отображать 
верхний слой. Но перемещая движки, мы устанавливаем новые условия отображения. 
Движок «This Layer» заставляет Photoshop отображать верхний слой в зависимости от 
яркости самого верхнего слоя. Движок «Underlying Layer» - в зависимости от яркости 
изображения, созданного нижележащими слоями. Каждый движок можно разделить на 2 
части. Тогда между двумя половинками движка образуется зона перехода – зона где 
Photoshop смешивает верхний и нижние слои, чтобы не было видно перехода. 
Я применил к слою кривых «Curves a» установки Blend If как на рис. 51 
 

 
Рис. 50 
 



 
Рис.51 
 
Теперь слой кривых применяется к изображению только там где изображение не очень 
темное и не очень светлое. Одновременно действует и второе условие. Применять кривые 
только в области положительных значений слоя B, т.е в области желтых оттенков.  
При установки движков в такое положения я руководствовался следующей идеей: 
Защитить от коррекции периферию и самый центр галактики. Красноватая периферия 
выглядит не естественно. Центр же на мой взгляд должен быть ослепительно белым. Это 
подчеркивает яркость центра. 
Условие по каналу B позволяет защитить от воздействия область синего гала галактики. 
На рис. 52 приведен результат применения кривых в канале A с использованием «Blend 
If» 
 

 
Рис. 52 
 
Цветокоррекция почти готова. Однако, центральная часть галактики кажется мне не 
достаточно «теплой». В канале B между прожилками темных туманностей значения 
скачут в районе -4. Это свидетельствует о голубых оттенках. 



Я создаю еще один корректирующий слой кривых поверх слоя «Curves a» и называю его 
Curves b+ и устанавливаю кривые только для канала B как показано на рис. 53 
 

Рис.53 
В итоге происходит небольшой сдвиг средней части галактики в область теплых тонов. 
Результат приведен на Рис.54. Теперь цветокоррекция галактики закончена! 
 

 
Рис.54 
 
Стек слоев приведен на Рис. 55 
 



 
Рис.55 
 
Подведем итог перед финальным рывком. Мы произвели коррекцию цвета галактики. 
Скрытые цветовые вариации М31 на лицо. Весьма агрессивная цветокоррекция, тем не 
менее, не привела к появлению посторонних оттенков и кислотных цвет в силу двух 
факторов: 

1. Звезды были отделены от галактики. Звезды подпорченные хроматизмом – первые 
кандидаты на появление неестественных цветов при попытках усилить цвета 
объекта. 

2.  На всех этапах в LAB я использовал кривые с ограничением коррекции в области 
уже насыщенных цветов. 

Что нам осталось сделать? 
После увеличения насыщенности цветов резко возросли шумы в канале B. Необходимо их 
подавить. Насыщенные цвета смотрятся не очень естественно без усиления контраста в 
яркостном канале. Усилим контраст.  
Звезды имеют следы хроматизма. Необходимо будет ослабить характерные для 
хроматизма оттенки на звездах. 
 
Удаляем шум в канале B. Для этого копируем слой «M31 With Out Stars» и располагаем 
его поверх «M31 With Out Stars». Делаем активным вновь созданный слой, заходим в 
палитру «Channels», делаем активным и видимым только канал B. Размазываем его при 
помощи фильтра Gaussian Blur c радиусом 5 пикселей. Даем слою новое название «M31 
With Out Stars GB 5px.». Чтобы избежать эффекта замыливания я снижаю прозрачность 
этого слоя на глаз до 67%. Теперь нижней зашумленный слой слегка просвечивает и 
изображение выглядит более естественно. Кроме того, регулируя прозрачность слоя «M31 
With Out Stars GB 5px.» можно влиять на степень шумоподавления. 
Повышаем контраст.   
Копирую слой «M31 Without Stars» и располагаю его поверх слоя M31 With Out Stars GB 
5px.» Делаю слой активным. Захожу в палитру «Channels» и оставляю активным и 
видимым только канал L. Применяю к каналу L последовательно 3 раза фильтр Unsharp 
Mask со следующими параметрами: 
1 раз: Amount 25%, Radius 16, Threshold: 0  
2 раз: Amount 35%, Radius 8, Threshold: 0  
3 раз: Amount 45%, Radius 4, Threshold: 0 
Применение фильтра с разными радиусами позволяет избежать усиления деталей только 
одного размера. Значения  Amount подобраны опытным путем. Прозрачность полученного 
слоя снижаю по вкусу до 61%. Название слоя меняю на «M31 Without Stars USM 16px 
25%, 8px 35%, 4px 45%». 



Цветокоррекция галактики закончена. Остался небольшой паразитный оттенок фона и 
цветовой шум в области фона. Его легко убрать, достаточно просто ослабить цветовую 
насыщенность изображения в области фона. Это уберет паразитный оттенок и снизит 
шум. При этом никакого размазывания не потребуется. 
Я создаю корректирующий слой Curves поверх слоя «Curves b+» и называю его 
«Background Color Rejection». На рис. 56 приведены параметры слоя. Кривая для 
яркостного канала оставлена без изменений. Кривы для каналов цвета сделаны пологими. 
Это приводит к ослаблению цвета. В меню «Bled If:» ползунки установлены таким 
образом, чтобы слой был видимым только в областях с низкой яркостью изображения, т.е. 
о области фона. В данном случае «Bled If:» эквивалентно использованию инверсной маски 
яркости. Стек слоев после подавления цвета фона приведен на рис. 57. Результат можно 
увидеть на рис. 58. Осталось только разобраться со звездами. На рис .59 А) приведен 
фрагмент изображения до коррекции звезд. Бросаются в глаза красные и синие ореолы 
вокруг звезд. Их необходимо ослабить. Просто снизить насыщенность цветов – не выход. 
Тогда будут ослаблены как сильные оттенки (следы хроматизма), так и слабые оттенки, 
которые отвечают за естественные цветовые вариации звезд. В Цветовом пространстве 
LAB это делается легко при помощи одного слоя кривых (Curves). Я создаю новый 
корректирующий слой кривых и размещаю его поверх слоя «Stars». Слой получает 
автоматом название «Curves1». Установив курсор на палитре «Layers» строго на границе 
между слоями «Stars» и  «Curves1», я нажимаю клавишу «Alt» и кликаю мышкой. Теперь 
слой «Curves1» привязан к слою «Stars» и оказывает свое влияние только на него. 
Стек слоев приведен на рис. 60 Форма кривых показана на рис. 61. Для L канала я оставил 
кривые без изменения. Они на рисунке не показаны. Логика построения кривых на рис. 61 
следующая: Основной хроматизм на звездах выражен в ярко красных ореолах. Я 
заваливаю кривую для канала A в правой части, которая отвечает за красный цвет. Для 
всех цветов, значения которых в канале А ниже 8, кривая не оказывает никакого действия 
(наклонный под 45* участок кривой). Всем цветам, которым отвечают значения A выше 
20, присваивается значение 10 (горизонтальный участок кривой). Область 8-20 является 
переходной. Данная кривая не оказывает никакого действия на зеленые оттенки и слабые 
красные. Насыщенный красный цвет кривая ограничивает. Аналогично строится кривая 
для канала B. Только теперь мы ограничиваем яркие сини оттенки. За них отвечает левая 
половина кривой. Поскольку синие ореолы у звезд выглядят более естественно, чем 
красные я ограничиваю кривую для канала B более плавно на уровне -45. На этом 
обработка галактики M31 закончена! Финальный результат представлен на рис. 62. 
 
 



 
Рис. 56 
 

Рис. 57 



 

 
Рис.58 
  

 
Рис.59 
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Рис.62 
 
В заключении, хочу обратить внимание на «гибкость» обработки а точнее, гибкость 
финального .psd файла. Не редко, закончив обработку сегодня уже завтра я хочу ее 
немного скорректировать. Увеличить или уменьшить контраст, изменить ту или иную 
настройку цвета. Побудить изменить обработку нас может мнение коллег или похожий 
снимок в сети. Хорошо если итоговых .psd файл позволяет это сделать. Файл текущей 
обработки M31-Lab.psd я старался сделать именно таким. Ниже сформулированы 
принципы построения. 

1. Все ключевые настройки необходимо делать на отдельных слоях. 
2. Необходимо иpбегать настроек кривых и уровней непосредственно на слое 

(Image>Adjustments). Целесообразно использовать корректирующий слой 
(Layer>New Adjustment Layer) 

3. Усиление контраста и подавление шумов следует делать на отдельном слое. 
4. Выполняя любую корректировку на отдельном слое следует уменьшить его 

непрозрачность до 70-80%. Это позволит Вам в будущем как усилить влияние 
этого слоя повышая непрозрачность, так и уменьшить его влияние. Если 
корректирующий слой имеет непрозрачность 100%, то Вам остается только 
уменьшать его влияние на изображение понижая непрозрачность. 

5. По возможности, все слои в стеке должны вносить свой вклад в итоговое 
изображение. 

6. Если есть возможность отказаться от маски в пользу инструмента «Blend If:», 
нужно это делать. Ползунки «Blend If:» гораздо более мобильный инструмент, чем 
статическая маска. 

7. Звезды должны быть отделены от туманностей и галактик если это позволяет 
изображения. На снимках млечного пути, сделать это часто бывает не возможно. 

В файле M31-Lab.psd все слои оказывают свое влияние на итоговое изображения. Просто 
регулируя их непрозрачность Вы можете сильно повлиять на изображение. Затронув же 
ползунки «Blend If:» на тех слоях, где данный инструмент активирован, Вы множите 
изменить изображение еще сильнее. По сути, файл в приложении это рабочая заготовка, 
которая позволит Вам сделать Андромеду такой, какой ее представляете Вы сами. Удачи! 
Надеюсь, статья была Вам  полезна. 
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Приложения: 

1. out_8min_crop.pic Исходное изображение галактике после калибровки и 
кадрирования в IRIS. Используется в Части 1. 

2. M31-RGB.psd  Рабочий файл обработки галактики в Photoshop CS3 в цветовом 
пространстве RGB. Используется в Части 2. 

3. M31-Lab.psd. Рабочий файл обработки галактики в Photoshop CS3 в цветовом 
пространстве LAB. Используется в Части 3. 

4. лен-область.psd. Иллюстрация быстрой цветокоррекции в цветовом пространстве 
LAB. Используется в Части 3. 
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